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Abstract
The use of mobile low cost sensors for regulatory purposes or citizen observatory projects is quickly developing. Although
several sensor systems have appeared the last years, generally developers cannot tackle the whole set of open problems
regarding their use and the accuracy of the information they provide. Currently air pollution using low cost sensors
involves fast growing private companies and/or public institutes specialized in digital technologies. Unfortunately, a great
deal of effort is wasted by repeating the same research by several private companies/public institutes or within several
European projects. Moreover, when a technological solution is found, it is generally subjected to confidentiality aspects of
the intellectual property right.
In order to facilitate the use of sensors by diminishing the operational and development costs, the Joint Research Centre is
developing a multi-sensor platform, called AirSensEUR, for the monitoring of air pollution at low concentration levels. All
development aspects owned by JRC about AirSensEUR is made available to all stockholders though the use of public
licenses. AirSensEUR is developed as an open software/open hardware object that has the capacity to behave as a node
within a network of multi sensors assuring interoperability and compliance with the INSPIRE Directive.

Executive summary
The issue of using mobile low-cost sensors by local authorities, laboratories in charge of air
quality monitoring for regulatory purposes or by citizens is quickly developing. Several sensor
systems have been developed in the last years by fast growing private companies and/or public
institutes specialized in digital technologies. Unfortunately, these sensors do not give satisfaction
for all desired functionalities including the measurement accuracy of the sensor systems, the
localization and identification of the micro-environments being sampled and the reporting of
these data in order to make them available to all stakeholders through the Web services.
Moreover, a great deal of effort is wasted by repeating the same research by several
companies/institutes or within research projects. Additionally, new technological solutions that
may be found are generally subjected to confidentiality of the intellectual property rights
preventing them to be widely applied.
In order to facilitate the use of sensors by diminishing the operational and development cost,
the Joint Research Centre (JRC) is developing a multi-sensor platform, called AirSensEUR, for the
monitoring of air pollution at low concentration levels with low-cost sensors. JRC makes all
development aspects about AirSensEUR freely available through the use of public licenses. In
fact, AirSensEUR is developed as an open software/open hardware object that has the capacity to
behave as a node within a network of multi sensors assuring interoperability and compliance
with the INSPIRE Directive (Infrastructure for Spatial Information in the European Community).
The JRC objective was to build both the AirSensEUR host platform able to connect with
several sensor shields to be later developed and to develop the first sensor shield for air
pollution sensors. The sensor shield is connected to the host in charge of collecting the
measurements. The host supplements measurements with geographical coordinates and it sends
data to a public database on the web where mapping and query services are available.
This report describes the sensor shield while the AirSensEUR host will be presented in
another EUR report. The electronic diagrams of the shield are given together with a firmware for
the micro-controller, a Java Front End panel to easily configure all the sensors and a protocol to
exchange data through a serial communication port between the shield and the host or any other
controller with a COM to USB port. The shield consists of an electronic board with 4 sensor
channels and a deported board with temperature, relative humidity and pressure sensors. Many
models of 2-electrode and 3-electrode amperometric sensors can be mounted on AirSensEUR.
The shield can accommodate sensors of Alphasense, City Technology, Membrapor and SGX
Sensotech, the major manufacturers of this type of sensors.
A laboratory evaluation of the performances of Sensoric-City Technology sensors fitted on the
AirSensEUR shield is also reported. For this evaluation O3, NO2, NO and CO sensors were
mounted on this shield. The experiments carried out in laboratory showed that AirSensEUR is
easy to configure and sensitive enough to measure ambient air pollution in the range expected at
background and traffic sites placed in rural, urban and suburban area. However, a solution for
the interference between O3 and NO2 and a correction for the temperature dependence of the
City Technology sensors shall be developed as for example an active sampling system including
an O3 and NO2 filtering module mounted on the sensor shied.
AirSensEUR is a promising technology for the monitoring of air pollution at fixed sites and for
population exposure in mobile context at low cost.
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1 Introduction
The use of low-cost sensors by laboratories in charge of ambient air monitoring for regulatory
purposes or by citizens is quickly developing. At the same time, low-cost sensors raise strategic
questions including the assessment of the quality of the information provided by those devices,
the localization and identification of the micro-environments being sampled and the automatic
reporting of this information so that it is available for all stakeholders using near to real time web
services.
Although several sensor systems have appeared in the last years, generally the developers do
not have the capacity to tackle the whole set of open questions regarding sensor systems.
Currently air pollution using low cost sensors involves fast growing companies and/or public
institutes specialized in digital technologies. Unfortunately, a great deal of effort is wasted by
repeating the same research by several companies/institutes or within research projects.
Moreover when a solution for one of the problem listed above is found, it is generally subjected
to the control of the intellectual property rights.
In order to facilitate the use of sensors by diminishing the operational and development cost,
the Joint Research Centre (JRC) is developing a multi-sensor platform, called AirSensEUR, for the
monitoring of air pollution at low concentration levels. All development aspects owned by JRC
about AirSensEUR are made freely available through the use of public licenses. AirSensEUR is
developed as an open software/open hardware object that has the capacity to behave as a node
within a network of multi sensors assuring interoperability and compliance with the INSPIRE
Directive [1]. We strongly believe in such a common and participative plan for the establishment
of a scientific community both of interested users and/or developers joining forces to build a
validated sensor system.
The JRC objective is to build both the AirSensEUR host platform able to simultaneously
control several sensor shields and to develop the first sensor shield for air pollution sensors to be
connected to the host.
The host integrates functionalities shared by sensor shields including GPS positioning, Linux
operating system and programming languages to control a list of I/O ports used by the shields
(COM, USB, SPI, I2C, PWM …) with sufficient RAM, CPU computing capacity and a micro-SD
storage up to 64Gb. Twined with the host platform we designed the 1st AirSensEUR sensor shield
for air pollution monitoring based on electrochemical sensors. Figure 1 gives the flow chart of the
AirSensEUR platform with the whole set of functionalities that is planned to develop.
The development of the sensor shield (block A1) is now complete (version 2.2). The host is in
its final development state. The final version is expected to be available in fall 2015. We have
started designing 2 handling boxes, one for the host and one for the shield. We expect that the
CAD files could be available at the end 2015 and distributed under public license. The laboratory
evaluation and calibration of the sensor shield was carried out for the O3, NO2, CO and NO City
Technology sensors (block A3). More evaluation should be carried out in particular for filtered or
other more sensitive sensor brands and models. However, these tests are not currently planned.
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Figure 1: Schematic diagram of the AirSensEUR platform

The data transfer to a server backend (blocks B1 and B2) has been developed in compliance
with the requirements of the INSPIRE Directive [1] using the Sensor Observation Services SOS
interface standard [2] and it is in validation stage. The remote transfer functionalities of
AirSensEUR will be published in the host report together with a cook book for the configuration
of the backend server.
The architecture of AirSensEUR based on well-established free and open source software, also
includes an Inspire view (through a Web Map Service - WMS), download services (block C1) and
the web observation dashboard (block C3) that gives the possibility to visualize time series plots
of data stored in the PostgreSQL database (block B) need be developed though they should
require limited effort to be set up.
The block C2 in Figure 1 is about the development of algorithms for the correction of sensor
measurements based on the reference measurements of automatic stations or using the results
of laboratory experiments in exposure chamber (block A3). Other possibility as the chemical
filtering of interference and on-board calibration possibilities will be studied. The final solution
of this module is expected to be ready in the 2nd half of 2016.
The host will have the capacity to act as an access point for a short time in order to save the
battery autonomy. A local web server will be created on the host allowing configuring each
sensor channel data acquisition and monitoring the sensor shield responses and the data stored
in the host data base (block D1). The web server and access point still have to be developed. It is
planned to be available in the first half 2016.
The addition of other functionalities as for example building a smartphone app for the nearto-real-time mapping of AirSensEUR observations, automatic detection of indoor/outdoor
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location, estimating population exposure based on data in the server backend database are
currently discussed.
This report presents the sensor shield (block A1) and the results of sensor tests (block A3).
The host platform will be presented in another EUR report likely at the beginning of 2016.

2 Copyright notices
The AirSensEUR shield consists of electronic diagrams, a firmware and a JAVA software, a list
of components and a communication protocol. The electronic diagrams, the firmware and the
JAVA software are released under Public License. The diagrams and software can be downloaded
at: ftp://ftp-ccu.jrc.it/pub/gerbomi/AirSensEUR and http://www.airsenseur.org/. In case the
FTP site would be deleted you are kindly suggested to contact by mail one of the authors.

2.1 Electronic diagrams
The electronic diagrams of the gas sensor shield, the board for temperature, humidity and
pressure and the COM-to-USB board are distributed under the Creative Commons Attribution
Share Alike Attribution, the CC BY SA 4.0 International (see 9). This license lets others remix,
tweak and build upon the work being done even for commercial purposes, as long as credit is
given as stated here below. New creations (any new works based on the current one) shall be
licensed under the identical terms, so any derivatives will also allow commercial use.
Additionally, any adaptation/improvement by third parties shall also be made available under
the same license preventing from private appropriation of improvements. The copyright notice is
as follows:

Copyright, European Union, 2015
JRC - Joint Research Centre,
IES - Institute for Environment and Sustainability,
Air and Climate Unit - (https://ec.europa.eu/jrc)
LiberaIntentio Srl (http://www.liberaintentio.com)
Released under Creative Commons Attribution-ShareAlike 4.0 International,
Reference Designs are provided "as is" and "with all faults".
Authors disclaim all other warranties, express or implied, regarding products, including
but not limited to, any implied warranties of merchantability or fitness for a particular
purpose.
You may obtain a copy of the Licence at: http://www.creativecommons.org
CC BY SA 4.0 International.
2.2 Software

The firmware and the JAVA software developed for the AirSensEUR shield are released under
the European Public License, an open source license for software. The copyright notice is as
follows:

Licence
Copyright 2015 EUROPEAN UNION
Licensed under the EUPL, Version 1.1 or subsequent versions of the EUPL (the "License");
You may not use this work except in compliance with the License. You may obtain a copy of
the License at: http://ec.europa.eu/idabc/eupl
Unless required by applicable law or agreed to in writing, software distributed under the
License is distributed on an "AS IS" basis, WITHOUT WARRANTIES OR CONDITIONS OF
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ANY KIND, either express or implied. See the License for the specific language governing
permissions and limitations under the License.
Date: 02/04/2015
Authors
- Michel Gerboles, michel.gerboles@jrc.ec.europa.eu and Laurent Spinelle –
laurent.spinelle@jrc.ec.europa.eu, European Commission - Joint Research Centre,
- Marco Signorini, marco.signorini@liberaintentio.com

3 Technical description of the AirSensEUR shield
The AirSensEUR shield is a multi-sensor platform developed starting from the results of the
MACPoll project ([3]–[7]). In developing the shield, the following objectives and functionalities of
the shield were considered:


to be able to manage 4 gas sensors consisting of 2/3 electrode sensors. Lately, a
modification of the Printed Circuit Board (PCB) has allowed the use of different brands and
models of sensor (see 4.1).



to include auxiliary measurement for temperature, relative humidity and pressure. These
parameters would be used both for information and they could also be used in correction
algorithms of the sensor responses.



to reach high accuracy and high resolution for the sensor responses.



to build an open software/open data object



to allow the configuration of each sensor channel in a simple way (without reprograming).

Keeping these objectives in mind, we adopted the following technical solutions listed in the
same order as the list of objectives:
1. amperometric sensors were found convenient taking into consideration the low electronic
noise and the ease of operation of these type of sensors. We selected the NO2 3E50 for
nitrogen dioxide, O3 3E1F for ozone adding the NO 3E100 for nitrogen monoxide and CO
3E300 for carbon monoxide form City Technology though other brands are available
(Alphasense, City Technology, Membrapor and SGX Sensortech (see 9.3).
2. for temperature, relative humidity and pressure, two sensors (a Sensortech UR100CD for
temperature and relative humidity and a Bosh BMP180 [8] for pressure) are mounted on
small PCB that can be directly connected on the shield or can be connected with long wire.
3. the electronic circuitry was optimised to avoid temperature drift. We tried to balance the
component prices with the selection of high quality electronic components in order to
improve the stability and reduce electronic noise. Each sensor channel is composed of a fully
programmable Analog Front End (AFE) with a dedicated Integrated Circuit. Regarding the
electronic resolution, for each channel, a 16 bit analogic-to-digital converter (ADC) was used
in conjunction with a digital-to analogic converter (DAC). The DAC is used to set the limit of
the ADC. In this way, even little change in signal can be detected, as the ADC resolution reach
the µV range.
4. all electronic schemes and software are published under public license (see 9). The
diagrams and software allows using the major part of the 2 and 3-electrode sensors
currently available on the market (see 4.1). We also give the Bill of Materials (BOM, see 9.2)
and a communication protocol allowing to use of the shield with any controller including a
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COM port (see Appendix 9.4). However, the PCB diagrams are not published as they are the
property of LiberaIntentio1. For the micro-controller of the shield, we chose an ATMega328
Atmel CPU [9] that allows the use of the open Arduino environment [10], [11] for
programming and uploading of the firmware. The micro-controller interoperates with the
signal processing (ADC and DAC), retrieves the digital samples of each sensor and transmits
raw signals to the AirSensEUR host board (an Arietta G25 from ACMESystem-IT [12]). Any
similar rapid controlling system could be used through a serial line.
5. a JAVA control panel allows configuration of the Analog Front End (AFE) of each sensor. It
offers the possibility to independently optimise the bias potential, load resistance, and
sensitivity parameters. It is also used to set up the filtering of electronic noise and the
averaging time of each channel. The Java Front End directly sets up the shield microcontroller that interoperates with the signal processing system (ADC, DAC and AFE).

3.1 Shield

The architecture of the sensor shield is given in Figure 2. The left block represents the gaseous
sensor interface. It is composed of a fully programmable Analog Front End (AFE, TI LMP91000,
Texas Instruments, US [13]), a 16-bit A/D converter (TI ADC16S626 [14]) and a 12bit D/A
converter (AD5694RB). The D/A converter is used to dynamically set the range of the A/D
converter in order to keep its resolution in the sensor output range. It has been added during the
development of the shield in order to allow keeping a good resolution when acquiring very low
voltages. The best resolution of the data acquisition reaches 15.3 µV when the board is set to a
full range of ±0.5V taking the 16 bits of conversion of the ADC into account. As the sensors give a
change of 0 and 10 mV for NO2 and SO2 in the 1000 ppb range, the sensor board resolution is
well consistent with the sensitivity of the sensors and range of pollutants in ambient air.
The right block includes of a block containing two digital sensors: one for both temperature
and relative humidity measurements (UR100CD see 5) and one for pressure measurements
(Bosh BMP180 [15]), together with the needed power supply and an I2C level shifters to
interface to the micro-controller. The level shifter is used to shift the voltages of the bus signals
so that devices of different voltages can communicate over the same bus of the micro-controller
[16].
Finally the central element consists of a micro-controller ATMega328 [9]. It’s in charge of
properly setup both the analog front ends of the 4 chemical sensors, the A/D and D/A registers
and the external sensors (temperature, humidity, pressure). It also retrieves, filters and averages
the responses of the seven sensors and concatenated all of them into a hexadecimal string. The
microcontroller provides a serial line which is used to interface with the external host. The
ATMega328 can receive a firmware by the onboard serial connector through an USB to Serial
adapter compatible with the Arduino framework and integrated development environment
(IDE).
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Figure 2: Block schematics representation of the sensor shield

An USB board (USB2Serial see diagram in Appendix 9.1) plugged on the shield allows realtime data acquisition of the data for example for laboratory calibration without the need of the
AirSensEUR host. Additionally, a communication protocol and a JAVA control panel has been
developed in order to easily configure the AFE of each channel (sensor voltage, D/A outputs, A/D
conversion limits, gain, load resistance of each sensor -RL, bias, IIR filtering [17], DAQ periodicity
and averaging time) and read sensor responses. All the above mentioned parameters are
explained in the section 3.2 below.
The shield was designed with:








4 programmable high precision three leads chemical sensor AFE [13]
4 high precision 16 bit A/D converters [14]
4 12bit D/A converters (AD5694RB)
a ATMega328 processor running at 16MHz [9]
a linear power supply regulators
a single 6V power supply, polarity protected
an opto-coupled USB2Serial acquisition board

In order to keep the resolution of the 16 bit of A/D converter in the useful range of sensor
outputs, a 12bit D/A converter (AD5694RB) was included before the AFE and the sensor. In that
way the range of the sensor response can be pre-set and the quantum resolution of the A/D
converter (16 bit) is kept undivided. Each D/A converter is able to generate 3 analogue voltages
used as references by both A/D converter and AFE. Figure 3 shows the logical scheme of one
sensor channel with the D/A converter (bottom) which generate the 3 reference voltages (VOA,
VOB and VOC) used by the A/D converter (VOA and VOB) and by the AFE (VOB and VOC).

Figure 3: Logical scheme of one sensor line (see Appendix 9.1)
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The shield is also equipped with a daughter board in order to measure temperature, relative
humidity using a UR100CD sensor (see Appendix 9.2.3) and pressure sensors using a Bosh
BMP180 sensor [15]. The Appendix 9.1 shows the schematics of this daughter board. The digital
sensors are factory calibrated and operate through I2C digital bus. The UR100CD sensor
monitors temperature with an accuracy of ± 0.3°C and relative humidity with an accuracy of
±2%. The Bosh BMP180 has a typical absolute accuracy of 0.1hP and a resolution of 0.01hP. Both
sensors were selected because of their high sensitivity and high accuracy with low power
consumption. The responses of these sensors being digitized, they do not suffer interference
from temperature, electromagnetic fields etc… when used in field. Equation 1, Equation 2 and
Equation 3 are used to transform response signals into temperature in °C, relative humidity in %
and atmospheric pressure in hPa.
Temperature:

Relative humidity:
Pressure:

𝑇=(

𝑇𝑠 × 165
) − 40
16384

Equation 1

𝑅𝐻𝑠 × 100
16384

Equation 2

𝑅𝐻 =

𝑃=

𝑃𝑠
48

Equation 3

Figure 4 shows the logical scheme of the microcontroller of the shield and the interface with
the 4 sensors channels. The micro controller is the ATMega328 Atmel microcontroller [18]. It
operates at 16MHz and is factory programmed with optiboot [19]. This solution grants a
complete compatibility with the Arduino platform allowing users to easily implement a custom
firmware through the Arduino IDE [10]. The communication between the shield and the

Figure 4: logical scheme of the micro-controller and connection to the 4 sensors (see Appendix 9.1)

computer through using a dedicated slot for an external Arduino USB2Serial programmer [20].
An additional USB2Serial acquisition board was also developed for calibration purpose. To
avoid electronic noise interaction, especially from the different ground, this board mounts side
by side 2 opto-coupler used as an isolating system (see Appendix 9.1). This is particularly useful
with the low voltage expected with the selected sensors. Both samples and configuration
commands are exchanged with an external host through this USB2Serial acquisition board using
a TTL serial interface. These tasks can also be done using a commercial USB2Serial programmer.
However, as the data communication lines (serial Tx and RX) are shared between the USB2Serial
acquisition board and the USB2Serial programmer, the shield must be disconnect from
USB2Serial acquisition board and power supply in order to upload new firmware in the
ATMega328 through the USB2Serial programmer.
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3.2 Software
3.2.1 Firmware
A few parameters of the analogic and digital sensors are configured using the USB2Serial
acquisition board. Once set up, they are saved in the non-volatile memory embedded on the
ATMega328. When powering up the shield or after a reset, the microcontroller reads all the
coefficients from the non-volatile memory and automatically sets up the hardware.
With a periodicity set by the user, a custom firmware samples the sensors, performs a set of
basic statistical operations then mark samples with a progressive timestamp. Figure 5 shows the
flow chart of the firmware logic that thrives to minimize the ATMega328 calculation load. The
process is applied to the 7 sensors of the shield. In this figure, IIR stands for Infinite Impulse
Response filter [17]. Below are the different parameters that can be set and the related action
performed by the firmware:







Sampling rate of sensors, entered as ticks corresponding to a periodicity in of 10 ms.
The sampling frequency is Fs = 1/Periodicity of measurements.
Two different Infinite Impulse Response filters are applied using 2 different filter
coefficients.
Decimation filtering, called Ratio, is used to discard samples in order to limit the CPU
load in case of wide moving average (see below). The ratio of the decimation filter is
used to discard samples based on the Ratio parameter. The output of the decimation
filtering consists of Fs/Ratio samples per seconds.
The Moving average, with size called Length corresponding to the number of data
after decimation that are averaged. This moving average filter releases data at the
rate of Fs/(Ratio*Length) samples per seconds.
The output data is timestamped before being stored on a temporary buffer to be read
by an external host

Figure 5: Flow chart of the firmware logic

More details of the setting of the firmware and parameters are given below (3.2.2). The solid
arrows on Figure 5 mark data flow direction. The external host sends appropriate commands to
the Arduino controller over the serial communication channel following the defined protocol of
communication (see Appendix 9.4).
This communication is made through a serial line running at 9600bps, 8 bit, no parity. Line
level is 5V (TTL). The communication with the board is based on a request/answer protocol. The
commands are identified by sets of 1 letter and two or more digits encoded with hexadecimal
values. For each command, the board acknowledges by repeating the command itself and
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appending the answer. The full set of commands is reported in Appendix 9.4 with detailed
explanation, syntax and example.
This custom protocol was developed for the specific use of the lmp 91000 AFE used with City
Technology sensors. It can easily be adapted to fit any use by programming new commands or
reprogramming existing one. The firmware is programmed using the Arduino variant of C++. The
files can be downloaded on the website http://www.airsenseur.org/ or at the FTP site (sub
directory AirSensEUR/Shields/Software/Firmware/ChemSensorBoard).

3.2.2 Java Front End
A Java interface was developed to select and setup the AFE parameters and the filter
coefficients. This Front End can run both on a Windows or Mac computer. The communication
can be done through an Arduino USB2SERIAL programmer or by mean of the custom USB2Serial
acquisition board. In the case that the USB2SERIAL programmer is used for uploading
parameters, the shield is directly powered by the programmer. Thus an external power supply
for the chemical sensor board is not needed. The code source of the Java Front end can be
downloaded at the FTP server under AirSensEUR/Shields/Software/JAVA Front
End/ChemSensorPanel or at http://www.airsenseur.org/.

Figure 6: View of the Java Front End main panel

Figure 6 shows a view of the main panel of the Java interface. The main panel shows the
available RAM of the ATMega328 on the top left corner. The responses of the ambient sensors
are collocated on the right part. Finally the raw data coming from the gaseous sensor are
displayed by four time-series plots on the panel. Each plot reports the last 10 samples together
with the last valid timestamp for the associated sensor channel. The sensor responses
correspond to the voltage output of the sensors that are digitally converted by the 16 bit ADC
according to the range selected by sensor. For each sensor a set of 18 parameters can be tuned to
acquire/improve the sensor response. The configuration panel can be divided in 3 part:
Analog Front End parameters
The first parameter to be set is the name of the sensor. It is a length limited custom string
shown at the top of each plot panel. The name is associated to each chemical sensor and stored
into the non-volatile memory.
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Figure 7: Sensor’s configuration panel
(from left to right: AFE parameters, Reference voltage and Sampling parameters)

All the parameters needed to setup the Analog Front End in order to properly adapt it to a
specific sensor model as shown on the left view of Figure 7. Each parameter is a one to one map
with LMP91000 registers. Here is a list of all the parameters and the available configuration for
each:

Gain: defines the transimpedance gain applied. It can be set to 8 values: External, 2.75 kOhm,
3.5 kOhm, 7 kOhm, 14 kOhm, 35 kOhm, 120 kOhm and 350 kOhm. “External” corresponds to
an external resistance of 1 MOhm. As this last possibility is independent form the AFE, accuracy
is not guaranty so it is advised to use this option only for debug/testing.

Load: defines the load applied to the chemical sensor output lead. The load can be set on 4
resistance values: 10 Ohm, 33 Ohm, 50 Ohm and 100 Ohm.

Reference Voltage Source: correspond to the source of the analog reference voltage used by

the AFE to generate bias and internal zero voltages. 2 choices are available: Internal and
External. When Internal is selected, a fixed 5V is applied; when External is selected, the
reference voltage needed by the AFE is generated by the external D/A converter.

Internal Zero: defines the ratio over reference source used by the AFE to generate the internal
zero voltage. 4 set can be used: 20%, 50%, 67% and Bypass.
Bias polarity: defines the polarity of the generated bias analog voltage which can be Positive
or Negative.

Bias percentage: defines the ratio over reference source used by the AFE to generate the bias

applied to the chemical sensor. This potential is usually set between the sensing electrode and
the reference electrode. The bias percentage can be tuned between 0% to 24% by 2 % steps of
Ref AFE (see below).

Shorting FET: the LMP91000 included a Field Effect Transistor (FET) which can be used to
short cut the sensor when they are not powered. Enabled, Disabled turn respectively on and off
this FET. An additional FET was mounted externally to the AFE to guaranty the functioning.

Working Mode: defines the working mode of the AFE between:


Deep Sleep: the AFE is turned off. The sensor is not connected to the A/D converter. No



power is drawn from the power supply.
2 leads ground ref: the AFE is working in 2 leads ground referenced chemical sensors
topology. This option is not supported by the 3 electrodes amperometric sensors.
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Standby: the AFE is partially turned off. The sensor is powered and biased but the
transimpedance amplifier (Gain) is turned off.
3 leads amp cell: defines the working mode used in this project with 3 electrodes
amperometric sensors.
Temp (TIA ON): the output of the AFE is connected to the embedded temperature
sensor maintaining the transimpedance amplifier (Gain) on.
Temp (TIA OFF): the output of the AFE is connected to the embedded temperature
sensor but the transimpedance amplifier (Gain) is turned off for power saving.

For example, City Technology sensors already advices the value of bias potential, polarity, and
load resistor for its sensors in a technical note [21]. Table 1 gather the information applied on the

Table 1: AFE configuration recommended by the manufacturer

Sensor name Bias potential Polarity Load resistor
O3 3E1F

0

-

100 Ohm

NO 3E100

+200

+

100 Ohm

NO2 3E50

0

-

47 Ohm

CO 3E300

0

+

33 Ohm

AFE extracted from the manufacturer technical note for the selected sensors.
Reference voltage
This panel is dedicated to the setup of the different reference voltage applied to the sensor
and the electronic. 4 parameters can be modified: Ref-, Ref AD, Ref AFE and Gain, (centre view
Figure 7).

Ref-: defines the reference voltage applied to the A/D converter inverting input (Vin-).
Ref AD: defines the reference voltage applied to the A/D converter as Vad.
Ref AFE: defines the reference voltage applied to the Analog Front End. This option is active
only when the Reference Voltage Source is set on External mode.

Gain: defines the range of the reference voltages generated by the onboard D/A converter. The
range are define from 0 to 2.499V if x 1 is selected and from 0 to 5V for x 2.

The first two parameters (Selected Internal Zero Voltage and Selected Bias Voltage) are only
read values which depend on the other parameters as explained below.

Selected Internal Zero Voltage: is calculated as a percentage of the Ref AFE defined in the
Internal Zero of the Analog Front End parameters.

Selected Bias Voltage: is calculated as a percentage of the Ref AFE defined in the Bias
percentage and affected by the Bias polarity of the Analog Front End parameters.

Sampling parameters
As already explained in the section 3.2.1, our custom firmware samples sensors values and
performs a set of basic statistical operations on a periodical basis (right view Figure 7). Those
sampling/filtering parameters are defined as below:
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Sample Rate Prescaler: defines the main sample rate period for the A/D converter. It can
vary from 1 to 100 and is expressed in ticks. 1 tick is equal to 10ms which means that the sample
rate can vary from 100Hz down to 1Hz.

IIR1 Coefficient and IIR2 Coefficient: defines the denominator value for the coefficients of
the Infinite Impulse Response filter [17] apply on the raw value. This kind of filter has been
chosen for its efficiency and its small load of the internal RAM. Values available are: Disabled,
1/2, 1/4, 1/8, 1/16, 1/32, 1/64, 1/128.

Decimation Filter Size: defines the decimation filter ratio from Every 1 sample to Every 256
samples.

Moving Average Window Size: defines the size of the moving average windows, from 0 to 60
samples.
3.3 Power consumption
A measurement of the power consumption of the AirSensEUR shield was done during
laboratory’s experiments. The shield was fully operational with 4 gaseous sensors form the City
Technology Company and the daughter board (temperature, relative humidity and ambient
pressure) with a sampling rate set as described in 4.4. The consumption did not overpassed
20mA with a 5V power supply equivalent to 0.100W

4 Assembling the AirSensEUR
4.1 Getting the PCB

Two types of PCBs are necessary:

1. The AirSensEUR sensor shield PCBs, which includes the sensor shield, the daughter board
for temperature, humidity and pressure and the USB2Serial board schemes. It is possible to
build your own PCBs from scratch using the BOM and the electronic schemes although the
easiest way is to purchase them at LiberaIntentio1.
2. An Arduino USB Serial Light Adapter that allow to upload the firmware to the AirSensEUR
sensor shield [22]. It can be bought for example on Rs-online, Mouser or Digikey.

4.2 Installing the firmware
The firmware can be preinstalled on each sensor shield by the supplier, LiberaIntentio.
However, if needed the firmware can be uploaded (see 4.2.1).
AirSensEUR is based on an ATMega328 microcontroller with Optiboot factory loaded.
Optiboot [23] is a small program (called bootloader) that runs each time the microcontroller is
reset or powered up. The bootloader waits some seconds for a specific set of commands coming
from the serial line and, if found, enters in a “programming mode”. This operating mode expects
to receive a binary file through the serial line thus erasing and programming the internal flash. If,
the specific set of commands were not found on the serial line, the bootloader starts the program
(if any present) located to a fixed flash memory address.
Optiboot can be found on each ATMega328 based board (for example the Arduino UNO™) and
on the AirSensEUR board. For this reason, AirSensEUR is “seen” by the Arduino IDE like a “plain
standard” Arduino UNO. Thus, AirSensEUR can benefit from a worldwide available open source
code and libraries targeted to ATMega328 based Arduino™.
A custom firmware was developed to instruct the ATMega328 microcontroller to properly
connect to other on-board peripherals on the AirSensEUR board, to generate the needed timings,
read samples, pre-process them by filtering and temporarily store on the microcontroller
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memory. This firmware is also responsible for the implementation of a serial protocol used by an
external host to setup working parameters and retrieve sampled data. This software is provided
as source code and needs to be compiled then uploaded to the AirSensEUR for the very first time
or if upgrade is needed. This operation can be done by following this step by step guide below.

4.2.1 Standard Operational Procedure, building and uploading the firmware
Step 1: Download and install the Arduino IDE
The Arduino™ IDE is available for Windows™ and Mac™ users. It can be downloaded from
https://www.arduino.cc/ [24] (see print screen below). In this guide we refer to the 1.6.5
revision. We chose the .zip version because it does not require any administrative privileges on
the target PC in order to be installed. The downloaded .zip package can be uncompressed in any
folder.

Step 2: Install external libraries
The AirSensEUR firmware requires two external libraries to be added. The first, “Timer One”,
helps for timing generation. The second, “MemoryFree”, is used to retrieve the amount of volatile
memory available for samples. The IDE helps the user to install those libraries through the menu
option Sketch → Include Library
The timing library is already listed on the
optional downloadable libraries. You can add
it with a couple of clicks.
By clicking on the Sketch → Include
Library → Manage Libraries, a Library
Manager panel is proposed (see image on the
right). Available libraries can be filtered out
by changing the Type and Topic selectors
and/or by typing a relevant keyword in the
edit box.
Filter by “Timing” topic, then type “Timer”
in the right edit box and you'll have a list with
all timer related libraries available.
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Select the “Timer One” library and click on the “Install” button (see image below). The library
is now downloaded and installed on the IDE.

The second required library is not
(yet) listed on the Library Manager
panel and, for this reason, needs to be
downloaded from github repository at
https://github.com/mpflaga/ArduinoMemoryFree
or
at
http://www.airsenseur.org/
Download the library as a .zip file and
store on a temporary folder.
To add the MemoryFree library to the
IDE, click on Sketch → Include Library →
Add .ZIP Library then select the
downloaded .zip file and confirm.
If all complete successfully, you should now have the two libraries listed on the bottom menu
(Sketch → Include Library) as shown below.
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Step 3: Compile the AirSensEUR firmware
The software developed for Arduino ™ platform are called “Sketches”. The IDE provides a
favorite folder where all user Sketches can be stored (“Sketchbook”). This folder is usually named
“Arduino” and is located on the user's Document folder. Copy the whole ChemSensorBoard folder
in your sketchbook and restart your IDE in order to have it visible on the menu File →
Sketchbook as shown below.

Click on Tools → Board → Arduino UNO to prepare the compiler for the AirSensEUR target.
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Then click on the “Verify” pushbutton (it's the most left round button on the top bar, identified by
a green flag mark) to start compiling the sketch for the AirSensEUR board.

As soon as the compilation terminates, you should see a message as the one below in the IDE
status panel.

Step 4: Upload the firmware to the AirSensEUR board
Connect your Arduino™ USB2Serial converter on the JP2 connector. The correct position is
when
the
USB2Serial
converter's component side is
oriented
to
the
Host
connector on the AirSensEUR
board (see right picture).
Connect the USB side to a
USB port on your PC.
Windows users need an .inf
file to be installed for the
Arduino™
USB2Serial
converter; please follow the
instructions that can be found
at the product site webpage.
Wait until your system
recognizes
the
Arduino
USB2Serial converter.
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Select the serial port where the USB2Serial is connected through the Tools → Port menu, then
click on the Upload button located at the top bar.

The procedure takes some seconds and it's confirmed by a message on the bottom status
panel. Congratulations. Your AirSensEUR board is ready to accept commands from the Java
AirSensEUR Panel configuration program.

4.3 Selecting sensors and the parameter of the AFE of each sensor channel

The sensor shield is designed to acquire simultaneously data from 4 gaseous sensors, from the
temperature/relative humidity sensor and from the pressure sensor. Based on the experiments
carried out during the MACPoll project ([3-7]), we developed the shield to use the 3-electrode
sensors from City Technology UK model Sensoric [12]. Initially, the City Technology sensors,
diameter 16 mm, are mounted using a TO5 connector (see Appendix 9.2.2). However, the shield
has been modified to accommodate other 2 or 3-electrodes sensor models by using different pin
connection including:


the sensors with 20 mm diameter, e. g. the 4 series of City Technology[25] or SGX
Sensortech [26], the “miniature” series of Membrapor [27] and the A sensor series of
Alphasense (Small sensor types A1, A3, AE, AF, AX, CE, CF and CX see [28])
 and the sensors with 32 mm diameter: e. g. the 7-series of City Technology or SGX
Sensortech, the Membrapor “Compact” sensor series or the B sensor series of
Alphasense .
Table 2 gives the type of sensors that can be used with each sensor channels. Figure 8 shows
the dimension and position of each sensor on the shield.
Table 2: types of sensors that can be used with each sensor channels of the shield

Connector type

Sensor Description

Sensoric (TO5 plug)
A/Miniature/4Series sensor
B/compact/7Series sensor

3 electrodes sensors, connector with 4 pins
2 or 3 electrodes sensors and up to 4 pins
(diameter: 20 mm, pin diameter: 1.5 mm)
2 or 3 electrodes and up to 4 pins
(diameter: 32 mm, pin diameter: 1.0 mm)

Sensor 1
and 4
X

Sensor 2
and 3
X

X

X

X

Appendix, 9.3 gives a list of the sensors manufactured by AlphaSense, City Technology and
Membrapor that are likely to work with the AirSensEUR shield. In general, the sensitivity of the
sensor decreases with their size: the 7-series are more sensitive than the 4-series that are in turn
more sensitive than the City Technology sensors. However, other parameters of the sensor
behaviour such as the drift over time, the cross sensitivities to other compounds, the effect of
temperature and humidity are important as well.
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Figure 8: Types of sensors that can be used on the AirSensEUR sensor shield on the 4 channels

Currently we have only tested the City Technology models O3 3EIF, NO2 3E50, NO 3E100, CO
3E300 so that the sole information will be given for these sensors. However, some other brand
and models show higher sensitivity for NO and would be worth testing.
Once sensors are selected, the pin connector for the 4-series or 7-series or the TO5 plug
should be welded on the PCB. One can use, for example, the pin connectors presented in
Appendix 9.2.2, choosing carefully the pin model fitted for the pin dimension of the selected
sensors. Finally the sensor and the daughter board for auxiliary measurements can be plug on
the PCB.

4.4 Setting the parameters of the sensors and the AFE of each channel with the
JAVA front-end
The JAVA Front End is launched after connecting the sensor shield to your PC either through
an Arduino USB2Serial converter (see below left picture) or with the AirSensEUR Serial2USB
board (see below right picture). In the latter case an external power supply shall be connected to
the sensor shield (at least 6 V).

The procedure is as follows:









Be sure to install a correct Java Run-Time Environment for your Operating System
(Java™ SE Runtime Environment 7 or higher)
Launch the ChemSensorPanael.jar found in AirSensEUR/Shields/Software/JAVA
Front End/Binary/ChemSensorPanel
Click on the menu BOARD
Choose CONNECT and select the Com port connected with the sensor shield and click
on CONNECT. Success should be written at the bottom of the window when the
connection has been established. Close the window.
Click on the menu BOARD and select the sensor to setup
When all the sensors are set up, click on the menu BOARD and click “Start sampling”.
In the main panel, the sensors responses are shown as described in Figure 6.
Click on the menu BOARD and select “Stop sampling “to stop the data acquisition.
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Table 3 gathers the parameters set up in one of the AirSensEUR shield during the evaluation
experiments. These parameters are given as example and should be modified/tuned for each
sensor mounted on the shield.
When starting the sampling process with the Java Front End, this one run a data acquisition
session. This Java application logs all the data in a text file on the shield. For each sampling
campaign (from start to stop), a csv formatted file is generated into the ChemSensoPanel folder.
Each file is named respecting the following pattern:

Sample_DDMMYYYY_HHMM.txt
where DD, MM, YYYY, HH and MM are, respectively day, month, year, hours and minutes of the
beginning of the campaign. Data are stored in consecutive lines according to the pattern:
C,SSSSS,TTTT. In this string, C is an integer identifying the channel (0 to 3 for the chemical
sensors, 4 for the pressure sensor, 5 for the temperature sensor and 6 for the humidity one),
SSSSSS is the ASCII value of the sample and TTTT is the ASCII value of the associated timestamp.
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Table 3: Experimental parameters chosen for the City Technology sensors presented in this report

sensor 1
O3 3E1F

Sensor 2
NO 3E100

Sensor 3
NO2 3E50

Sensor 4
Temperature Humidity Pressure
CO 3E300
350
N/A
N/A
N/A
kOhm
33 Ohm
N/A
N/A
N/A

Gain

350 kOhm

350 kOhm

350 kOhm

Load
Reference
Voltage
source
Internal
Zero
Bias
Polarity
Bias
Percentage
Shorting
FET
Working
Mode
Ref Ref AD
Ref AFE
Gain
Sample
Rate
Prescaler
IIR1
Coefficient
IIR2
Coefficient

100 Ohm

100 Ohm

100 Ohm

External

External

External

External

N/A

N/A

N/A

67 %

67 %

67 %

67 %

N/A

N/A

N/A

Negative

Positive

Negative

Positive

N/A

N/A

N/A

0%

10 %

0%

0%

N/A

N/A

N/A

Disabled

Disabled

Disabled

Disabled

N/A

N/A

N/A

3-lead amp
cell
1.674 V
±0.5 V
2.499 V
x1

3-lead amp
cell
1.342 V
±0.5 V
2.007 V
x1

3-lead amp
cell
1.674 V
±0.5 V
2.499 V
x1

3-lead
amp cell
1.699 V
±0.5 V
2.499 V
x1

N/A

N/A

N/A

N/A
N/A
N/A
N/A

N/A
N/A
N/A
N/A

N/A
N/A
N/A
N/A

10 ticks

10 ticks

10 ticks

10 ticks

10 ticks

10 ticks

25 ticks

1/4

1/4

1/4

1/4

1/4

1/4

1/4

1/8

1/8

1/8

1/8

1/8

1/8

1/8

Decimation

Every 5
samples

Every 5
samples

Every 5
samples

Every 5
samples

Every 5
samples

Every 5
samples

Every 5
samples

Moving
Average
Window
Size

30 samples

30 samples

30 samples

30
samples

30
samples

30
samples

30
samples

To use other sensors, the procedure given in the following figure may be applied to estimate
the parameters of the configuration of the sensor channels. This allows estimated the optimal
parameters from a data acquisition point of view. However, Ref- is likely affecting the chemical
reaction according to the electrode metals, type of sensor electrolyte and dimensions of the cell.
It seems that information about the best value for Ref- is not fully available. Thus it should be
estimated experimentally by users keeping in mind that when optimizing ref-, interactions refand the oxido-reduction reaction will take place.
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From data sheet: collect the sensitivity (A/ppm), Rload
(Ohms), Bias polarity and Bias potential (V)

Set Reference Voltage Source to external to use RefAFE in
the JAVA front End, If set to internal the ref. voltage is 5V

Negative: output decreases with increasing [] (NO2, O3 for example)
Min voltage (-), Min = sensivity.[].Rload.Gain (1 + Gain_Ohm/Rload_Ohm)
Ex. O3 3E1F Min = -450.10-9 x 0.1 x 102 x (1+350.103/102) = -0.015 V
Range of sensor ouptut: Min –0 (V)

Bias Polarity
Positive or
Negative?

Positive: output increases with increasing [] (NO, CO for example)
Max. voltage (+), Max = sensivity. []. RLoad. Gain (1 + Gain_Ohm/Rload_Ohm)
Range of sensor output: 0 –Max (V)

Previous high limit of Range that corresponds to 0 ppm
is now set to «Selected Internal Zero Voltage»

Previous low limit of Range that corresponds to 0
ppm is now set to «Selected Internal Zero Voltage»

«Selected Internal Zero Voltage» = Internal Zero x RefAFE). Check that it lays in [0.5-4.5] V by setting:
1- Internal Zero to 20% 50% or 67% of RefAFE (External) or 5V (Internal),
2-RefAFE to around 1.5 to 3.5 V, in order to reach the most linear and repetable range of the ADC
Note that by changing the Gain of RefAFE to x 1 or x 2, the full scale of RefAFE changes from 2.5 to 5 V.
For O3: RefAFE = 2.5 V, Internal zero = 67 % -> Selected Internal Zero Voltage = 1.675 V

Set the Shorting FET to Enabled to protect electronic circuit
Set working Mode to 3-lead amp cell

Set Ref- to the «Selected Internal Zero Voltage» for sensor with both positive or negative polarity (for
more resolution Ref- can be set in the middle of Range) Ex: O3 3E1F, Ref- = 1.675 V.
Set RefAD to encompass the Range. Minimum value for RefAD : ± 0.5 V due to the DAC. Resolution of
the ADC: 2 x RefAD / 216. Set Bias polarity and percentage: Selected Bias voltage = RefAFE x Bias
percentage x Bias polarity.

Figure 9: Procedure to follow to estimate the parameters of the configuration of the chemical sensors

5 Evaluation of sensor performances
5.1 Exposure chamber for laboratory tests

The gas sensors were evaluated in our in-house exposure chamber. This chamber allows the
control of gaseous interfering compounds, temperature, relative humidity and wind velocity
(Figure 10). The exposure chamber is an “O”-shaped ring-tube system, covered with dark
insulation material. The exposure chamber can accommodate the micro-sensors directly inside
the “O”-shaped ring-tube system.
A Labview software was developed for controlling the exposure chamber and for easy
programming of a set of experiments under different controlled conditions: temperature,
humidity, wind velocity, gas compounds (ozone O3, nitrogen monoxide NO, nitrogen dioxide NO2
and carbon monoxide CO), and other gaseous interfering compounds. It allowed setting criteria
for the stability of each parameter and for duration of each step. The software is also able to
manage data acquisition. All results (exposure conditions and sensors responses) are collected in
Access databases for latter data treatment. The data acquisition system had a frequency of
acquisition of 100 Hz and average over one minute when stored. During experiments, an
automatic system (PID feed-back loop) used the reference measurements of gaseous compounds,
temperature, humidity and wind speed to auto-correct the gas mixture generation system,
temperature controlling cryostat and wind velocity to reach the target conditions.

23

Figure 10: Exposure chamber for micro-sensors used in laboratory

5.2 Gas mixture generation system
For generating O3, two MicroCal 5000 Umwelttechnik MCZ Gmbh (G) generators were used.
These generators are equipped with UV lamps placed in thermos-insulted chamber whose UV
beam is controlled by a regulated current intensity.
CO, SO2 and NOx mixtures were directly generated by dynamic dilution from highly
concentrated cylinders from Air Liquide. NH3 and also NO2 were generated with an in-house
designed permeation system, using permeation tubes from Dynacal and Calibrage that were
weighed every 3 weeks.

5.3 Reference measurements of gaseous compounds in the exposure chamber

O3 was monitored using a Thermo Environment Model 49C UV-photometer. The analyzer was
calibrated before the experiments using an O3 primary standard. It consists of a TEI Model 49 C
Primary Standard, Thermo Environmental Instruments cross-checked against a long-path UV
photometer (National Institute of Standards and Technology, reference photometer n° 42, USA).
NO/NOx/NO2 were measured using a Thermo Environment Model 42i TL chemiluminescence
analyzer, calibrated against a permeation system for NO2 and a NO working standard consisting
of a gas cylinder at low concentration (down to 50 ppb) certified against a Primary Reference
Material of the Dutch Measurement Institute (NMI VSL – NL). SO2 was measured using an
Environment SA AF 21 M, calibrated with a working standard consisting of gas cylinder at low
concentration (down to 50 ppb) certified against a Primary Reference Material of NMI VSL - NL.
The calibration of the analyzer was confirmed by cross-checking with the permeation method.
CO was measured using a Thermo Environment Model 48i-TLE NDIR analyzer, calibrated with a
CO working standard consisting of a gas cylinder at low concentration (down to 1 ppm) certified
against a Primary Reference Material of NMI VSL - NL. For interference testing, NH3
concentration was estimated based on the dilution parameters. Finally CO2 measurements were
done using a differential non dispersive Infrared gas analyzer Li-cor 6262, calibrated with a CO2
cylinder (369 ppm for Air Liquide) and zero air obtained from an ultra-pure Nitrogen cylinder.
The sampling line of each gas analyzer was equipped with a Naflyon dryer to avoid interference
from water vapor on O3, NOx, SO2 and CO analyzer.
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In addition, some other parameters were recorded and/or controlled such as temperature,
relative humidity, wind velocity and pressure. Two KZC 2/5 sensors from TERSID (one with ISO
17025 certificate) were used to monitor both temperature and relative humidity. One sensor was
used to monitor in real-time using our in house LabView software, the second one was used to
register these parameters. The temperature of the exposure chamber was regulated using 3
refrigerated/heating circulators. One cryostat (Julabo (G) Model SP-FP50) was used to control
the temperature inside the exposure chamber, another one (Julabo (G) Model HE-FP50) for the
surface of the O-shaped glass tube and the last one (Julabo (G) Model HE-FP50) was devoted to
the control of temperature of the humid and dry air flows. These cryostats used a laboratory
calibrated pt-100 probe placed inside the exposure chamber. One wind velocity probes based on
hot-wire technology was used to monitor wind velocity. One pressure gauge DPI 261 from Druck
(G) was used to monitor pressure inside the exposure chamber. A fan ventilator was placed in
the chamber to control wind velocity through the LabView software control, Papst (G) model,
DV6224, 540 m³/hr.
To assure the quality control of the reference measurements, during the experiments, the O3
analyzer was monthly checked using a portable O3 generator SYCOS KTO 3 (Ansyco, GmbH - G)
certified against the laboratory primary standard (UV photometer NIST n°42). The NO2, SO2 and
CO analyzers were calibrated once a month using cylinders certified by the ERLAP laboratory.
ERLAP is ISO-17025 accredited (ACCREDIA-IT, n°1362) for the measurement of O3, NO2, SO2 and
CO according to EN 14625:2012, EN 14211:2012, EN 14212:2012 and EN 14626:2012,
respectively. Several tests were performed to confirm the homogeneity of exposure conditions in
the chamber at several positions in the exposure chamber.

6 Results
All the results are given for new sensors after a few days of warming in the chamber. In some
case, it has been observed that the results of these evaluation may change, for example the effect
of humidity on O3 sensors is no more linear after 6 months of use of the sensor.

6.1 Response time

The response time experiments were carried out during the MACPoll project but only for the
NO2 3E50 and O3 3E1F sensors, which will be presented in this paragraph. The response time of
sensors, t90, was computed by estimating t0-90 and t90-0, the time needed by the sensor to reach 90
% of the final stable value, after a sharp change of test gas level from 0 to 80 % of the full scale
(FS) (rise time) and from 80 % of FS to 0 (fall time). Four determinations of rise and fall time
were performed. The averaging time of the analyser was set to 20 seconds in order to get a fast
response. For this experiment, the controlled conditions in the exposure chamber shall be
established after a few minutes. Seen the internal volume of the exposure chamber (about 120 L),
it was decided to use the automatic bench that ERLAP uses for the European inter-comparison
exercises of the National Reference Laboratories of Air Pollution [29] that can generated mixture
with a flow of about 100 L/min.
Table 4: Response time of NO2 3E50 and O3 3E1F sensors

Sensors
NO2 3E50
O3-3E1F

Full scale
100 ppb
90 ppb

t90
98 s
60 s

t0-90
128 s
90 s

t90-0
68 s
30 s

Given that any change of an influencing variable would result in overestimating t90,
temperature, humidity and the interfering gas compounds (e. g. NO2 when testing O3) were kept
constant with Relative Standard Deviations (RSD) of within 1% at FS. For this experiment, the
controlled conditions in the exposure chamber shall be established after a few minutes. Seen the
internal volume of the exposure chamber (about 120 L), it was decided to use the automatic
bench that our laboratory, European Reference Laboratory for Air Pollution (ERLAP-JRC-IES)
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uses for the European inter-comparison exercises of the National Reference Laboratories of Air
Pollution (Barbiere et al., 2011) that can generated mixture with a flow of about 100 L/min.
Table 4 shows the t90 with the stabilization time of the exposure chamber and the response
times of the analyser being subtracted. Sensors in themselves are rather fast as they reach the
stability after less than 2 minutes.

6.2 Calibration
To check the conversion of the sensor responses into gas concentration units, a calibration of
each sensors against its target gas was performed. Levels of pollutant were selected to
correspond to the air pollution levels expected in ambient air. Figure 11 shows the calibration
plot based on a 45 minutes average with the standard deviations of the 45 values as error bars.
Temperature and relative humidity were kept under control during the experiment, respectively
22°C and 60 %.
Using linear models for NO, NO2 and CO sensors, the standard deviation of the residuals was
found equal to 4.7, 2.1 ppb and 0.01 ppm respectively. For O3, a quadratic model was applied to
slightly decrease the residuals to the reference values. It results in a standard deviation of the
residuals smaller than 0.9 ppb for the O3 3E1F.

6.3 Limit of detections

The limit of detection of the sensor was calculated using the standard deviation of sensor
values for 45 consecutive minute measurements at 0 ppb and 80 % of full scale. All parameters
suspected to have an effect on the sensor response (target gas, gaseous interfering compounds,
temperature and humidity) were kept under control with RSD lower than 1 %. The limits of
detection (see Table 5) were estimated as 3s where s is the standard deviation of repeatability
for the 0-ppb level.
Each sensor was calibrated independently, in the range of concentration levels expected in
ambient air. The limit of detection of the O3 sensor is well adapted to the level of ambient air
pollution. For the NO2 and NO sensors, whose sensitivities are lower, the averaging time must be
increased to reach acceptable levels, an hourly average allowing a limit of detection about 2.2
and 9.7 ppb respectively.
Table 5: Limit of detection of sensors, minute values

Sensors
Sensitivity,
nA/ppm
Shield output
signal, mV
Limit of
detection

O3 3EIF

NO2 3E50

NO 3E100

CO 3E300

471 (RL = 100 Ω)

215 (RL = 47 Ω)

44 (RL = 100 Ω)

83 (RL = 33 Ω)

14.5 @ 100 ppb

5.0 @ 100 ppb

7.6 @ 100 ppb

23 @ 1 ppm

3.2 ppb.min

16.7 ppb.min

74.9 ppb.min

0.056 ppm.min

6.4 Short and long term drifts

Short and long term drift experiments were carried out during the MACPoll project. They
were performed on sensors mounted on evaluation board from the City Technology-UK [25].
Here below, the evaluations for the O3 3E1F and NO2 3E50 sensors are presented. Further
laboratory testing should be performed in order to evaluate the short and long-term drifts for the
CO and NO sensors.
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Figure 11: Calibration of O3, NO2, NO and CO City Technology sensors mounted on the AirSensEUR
shield.

6.4.1 Short term drift
A few hourly measurements were carried out on several consecutive days at 0 ppb, 50 % and
80 % of the FS scale of the sensor when stable temperature, humidity and interfering gaseous
compounds conditions were reached. The short term stability was estimated using (1) where Rs
are the calibrated sensor responses at 50 % and 80 % of the FS at t0 (𝑅𝑠,𝑏𝑒𝑓𝑜𝑟𝑒 ) and 24 hours
later (𝑅𝑠,𝑎𝑓𝑡𝑒𝑟 ); N is the number of pairs of measurements. Figure 12 shows that the maximum
drifts were up to 1.9 and 2.6 ppb for O3 and NO2 sensors, respectively.
𝑫𝒔𝒔 =

∑𝑵𝟗
𝟏 |𝑹𝒔,𝒂𝒇𝒕𝒆𝒓 −𝑹𝒔,𝒃𝒆𝒇𝒐𝒓𝒆 |
𝑵
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Equation 4

Figure 12: Short term stability for the O3 3E1F (left) and NO2 3E50 (right) sensors.

6.4.2 Long term drift
For the long term drift, as for the short term drift, the study was carried out measuring sensor
response at 0, 60and 90 ppb for O3 and 0, 50, 100 and 150 ppb for NO2. The long term drift
stability was estimated using the trends of the sensor responses from the beginning to the end of
all laboratory experiment. As for the short term drift experiments, temperature, humidity and
gaseous conditions were kept under control (less than 0.4 °C and 0.4 %) in order to avoid that
their scattering may interfere with the sensor variability. Figure 13 shows that both the O3 3E1F
and the NO2 3E50 sensors suffer from a significant drift over a long period of time (150 days for
O3 experiments and 250 days for NO2). O3 3E1F shows an increasing drift whereas NO2 3E50
shows a decreasing trend. For each sensor type the slope of the drift changes linearly with the
test level.

Figure 13: Long term stability for the O3 3E1F (left) and NO2 3E50 (right) sensors.

6.5 Gaseous interfering compounds

Electrochemical sensors generally suffer from cross sensitivity to other gaseous species. O3,
NO2, NO, CO and SO2 were selected for interference testing and they were set at the levels
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expected in ambient air at background and traffic sites. The influence of each compound on the
sensors was determined once at a time in absence of other compounds. The levels of interfering
compounds were set at the same level as the ones of the calibration experiment (see Figure 11)
at the same temperature (22°C) and relative humidity (60 %) conditions. The sensors were
exposed for one hour after reaching stability and then three independent measurements were
performed. All gaseous compounds (apart from NH3 for which we relied on gravimetric values)
were measured using reference methods of measurement with a low expanded uncertainty of
measurements (less than 5 %) traceable to (inter)nationally accepted standards (see 5.3). The
sensitivity coefficients of the sensors to all tested gaseous interfering compounds are given in
Table 6.
Table 6: Results of interference testing, the sensitivity coefficients give the response of the sensors in
ppb per ppb of gaseous interfering compound, excepted for CO which is in ppm
Sensors
O3-3E1F

NO-3E100

Interfering
compounds
NO2
NO
CO
SO2
O3
NO2
CO
SO2

Sensitivity coefficients

Sensors

0.53 ± 0.026, ppb/ppb
-0.018±0.0030, ppb/ppb
-0.11 ± 0.035, ppb/ppm
-0.10 ± 0.017, ppb/ppb
-0.16 ± 0.033, ppb/ppb
0.23 ± 0.031, ppb/ppb
2.2 ± 0.23, ppb/ppm
0.52 ± 0.86, ppb/ppb

NO2-3E50

CO-3E300

Interfering
compounds
O3
NO
CO
SO2
O3
NO2
NO
SO2

Sensitivity coefficients
1.53 ± 0.015, ppb/ppb
-32 ±3.2, ppt/ppb
-1.22 ± 0.050, ppb/ppm
-2.48 ± 0.049, ppb/ppb
-0.74 ± 0.54, ppb/ppb
-7 ± 111, ppt/ppb
0.50 ± 0.080, ppb/ppb
-3.1 ± 5.3, ppt/ppb

Note: The effect of the long term drift on sensor was not corrected since it still had to be fully estimated. Thus the sensitivity coefficients
may be slightly incorrect (see 6.4.2).

The sensitivity coefficients are calculated as the slope of the linear relationships between the
calibrated sensor responses and the interfering compounds. Taking into account the typical
abundance of pollutants in ambient air and the sensitivity coefficients of Table 6, one can observe
that NO2 for O3 sensor and SO2/O3 for NO2 sensor are the major interfering compounds. For the
NO sensor, the sensitivity coefficients are significant O3, NO2 and CO. The CO sensor show the
lowest cross-sensitivities, likely because the levels of compounds are in the ppb range while the
sensor measures hundreds of ppb of CO. O3 and NO are slightly significant for the CO sensor.

6.6 Meteorological and physical parameters
6.6.1 Temperature and Relative Humidity
Sensor’s responses can also be influenced by changes of temperature or relative humidity. To
evaluate these effects, two series of tests were carried out including temperature and humidity
cycles while the main gas were kept constant. The range of relative humidity spread between
40% to 80% with 10% step in a hysteresis cycle with a 1st rise then 1 fall and finally a 2nd rise of
RH%). The same experimental setup was used for temperature. The range of temperature
changed between 7 and 37 ºC by step of 5 ºC (see Figure 14). The sensitivity coefficients of the
O3, NO2, NO and CO sensors are given in Table 7 with O3 and NO2 scatter plots in Figure 14. The
O3 and NO2 sensors highly suffered from changes of temperature and humidity. The CO sensor
appears to be unaffected by change in humidity or temperature while NO suffered a huge
dependence on temperature and a small one on humidity.
Table 7: Evaluation of temperature and humidity effect, the sensitivity coefficients give the sensor
responses in ppb, per Celsius degree and percentage of relative humidity
Sensors
O3-3E1F
NO 3E100

Influencing
variables
Temperature
Humidity
Temperature
Humidity

Sensitivity
coefficients
6.6 ± 0.090, ppb/°C
0.058 ± 0.055, ppb/%
-53.4 ± 0.76, ppb/°C
-0.17 ± 0.052, ppb/%

Sensors
NO2-3E50
CO 3E300

Influencing
variables
Temperature
Humidity
Temperature
Humidity

Sensitivity
coefficients
26.8±0.30, ppb/°C
0.56 ± 0.043, ppb/%
-25.6 ±1.4, ppb/°C
0.26 ± 0.82, ppb/%

Note: The effect of the long term drift on sensor was not corrected since it still had to be fully estimated. Thus the sensitivity coefficients
may be slightly incorrect (see 6.4.2).
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Figure 14: Example of temperature effect (upper row) at constant humidity level, and humidity effect
(lower row) at constant temperature for the ozone (left column) and NO2 (right column) on sensors

6.6.2 Hysteresis
Hysteresis is a shortcoming of a sensor when its response depends both on the current state
of the sensors and also on its past environment. During the MACPoll project, we evaluated the
dependence of sensors when exposed to the same levels of pollutants with a different trend. The
estimation of the dependence of sensors toward hysteresis was carried out by testing a ramp of
rising concentration of O3 or NO2 levels, followed with a ramp of decreasing level and finally with
a rising ramp. Both for O3 and NO2, almost no hysteresis effect could be observed (see Figure 15).

6.6.3 Final considerations
The City Technology O3 and NO2 sensors were also tested within the MACPoll project, using
the City Technology evaluation board in place of the AirSensEUR shield. The estimated sensitivity
coefficients are given in Table 8 [31]. While the sensitivity coefficients for interfering compounds
are similar in both studies, huge differences can be observed for temperature and humidity. They
were found much lower in Table 8. It is likely that the discrepancies come from the values of Ref-,
bias potential, Ref AD, Ref AFE and Gain that are given in Table 3 and that these values may need
further optimization.
Table 8: Gaseous interfering compounds: sensitivity coefficients (ppb/ppb or ppb/ppm for CO). For
temperature and humidity: sensitivity coefficients (ppb/°C or ppb/%).
Sensors

O3/ NO2

NO

CO

CO2
-5

O3 3E1F

0.76 (NO2)

-0.011

7.0 10

NO2 3E50

1.5 (O3)

-0.058

-1.6 10-3

3.5 10

30

NH3
-3

-1.3 10-2

1.6 10

-3

-1.1 10-1

Temperature

Humidity

1.3

-0.022

0.16

0.062

Figure 15: Example of hysteresis effect for the ozone (left column) and NO2 (right column) sensors

7 Conclusion
The AirSensEUR shield offers a route towards an open solution for the air pollution
monitoring at low concentration levels using low-costs sensors. The AirSensEUR shield is an
open software/open hardware object able to accommodate 4 electrochemical sensors together
with 3 auxilliary ambient sensors (temperature, relative humidity and pressure).
In this report, the element needed to use or develop this open object are presented, ease and
released. The laboratories experiments demonstrated that after correct configuration,
AirSensEUR is sensitive enough to measure sensor responses corresponding to change in
ambient air pollution.
The laboratory experiments showed that City Tech sensors mounted on AirSensEUR shield
are strongly affected by drift, cross sensitivities and temperature, while humidity effect is limited.
Our current objective is to design and apply a correction to these effects on the server side. As the
correction maybe different for each sampling site and/or each sensor it will be the responsibility
of each user to implement the appropriate correction even though we will thrive to give guidance
based on our available knowledge. Collaboration from expert from other institution is welcome.
The first objective is to use AirSensEUR for fixed measurements in order to limit the
complexity of the calibration function of the sensors. However, it is also promising technology for
the monitoring of population exposure in mobile context. It is likely that mobile measurements is
a more challenging objective that will need to develop algorithm able to solve transient change of
exposure.
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9 Appendix
9.1 Electronic schemes

In the following the overall scheme of the sensor shield, the daughter board and the
USB2Serial acquisition board are given
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9.2 List of components
9.2.1 Bill of material
Qty
1
8
4
4
4
4
17
8
2
42
1
4
1
1
4
4
1
12
1
1
1
1
1
4
1
1
4
1
1
0

Mouser, RSComponents, Digikey
Codes
667-ERJ-6GEYJ105V
667-ERJ-6GEYJ102V
156-049+674-2375
ED90274-ND (917-43-104-41-005000)
667-ERJ-6GEYJ103V
581-08055A100J
810-C2012X5R1A106K-3
660-RK73H2ATTD20R0F
581-08055A220J
80-C0805C104Z5V
667-ERJ-6GEYJ471V
77-VJ0805Y471JXXPBC
140-REA471M1ABK0811P
506-147873-1
584-AD5694RBRUZ
926-C161S626CIMMNOPB
556-ATMEGA328P-AU
81-BLM21RK121SN1D
571-2828372
156-049
156-049
720-LHR974-LP-1
156-049
926-LMP91000SDE/NOPB
750-CGRA4007-G
579-MCP1825S-5002EDB
771-PMBFJ177-T/R
576-1812L020PR
732-TX325-16F09Z-AC3
579-23LCV512-I/SN

Value

Device

1M
R_0805
1k
R_0805
2-wire
JP1E
3CHEMSEN
3CHEMSEN
10k
R_0805
10pF
C_0805
10uF
C_0805
20 1%
R_0805
22pF
C_0805
100nF
C_0805
470
R_0805
470pF
C_0805
470uF
CPOL-EUE3.5-10
147873-1
147873-1
AD5694RBRUZ
AD569XRRU
ADC161S626
ADC161S626
ATMEGA328P-AU
ATMEGA328P-AU
BLM21RK121SN1D
L_0805
DC
6V-9V
EXT-PROGR
PINHD-1X6
ExpHeader
PINHD-1X4
HB
LEDCHIPLED_0805
Host
PINHD-1X4
LMP91000SD
LMP91000SD
M7
DIODE-DO214AC
MCP1825SDB
MCP1825SDB
PMBFJ177
PMBFJ177
PTCPTCTSX-3225
TSX-3225
23LCV512-SN
23LCV512-SN
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Parts
R18
R1,
JP1,
SEN1,
R17,
C2,
C5,
R3,
C67,
C1,
R19
C3,
C69
RESET
IC3,
IC2,
IC17
L1,
W237-02P
JP2
JP6
LED4
JP4
IC1,
D5
IC18
TR1,
R20
Q1
IC19

R2,
R5,
R6,
R9, R10, R13, R14
JP3,
JP5,
JP7
SEN2, SEN3, SEN4
R21,
R22,
R23
C18,
C33,
C48
C6,
C9,
C14, C20, C22, C25, C28,
R4,
R7,
R8, R11, R12, R15, R16
C68
C4,
C7,
C8, C10, C11, C12, C13,
C19,

C34,

C49

IC6,
IC5,

IC9,
IC8,

IC12
IC11

L2,
X1

L3,

L4,

IC4,

IC7,

IC10

TR2,

TR3,

TR4

L5,

L6,

L7,

L8,

L9,

9.2.2 Plug and connectors

See or https://www.mill-max.com/new_products/detail/63
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9.2.3 Temperature humidity sensor
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9.3 Sensors brands and models for AirSensEUR shield (updated on 15/08/2015)
Alphasense[28]
Pollutant

Carbon
Monoxide

Type

A/Miniature/4

CO-AE

Sensitivity,
nA/ppm
10 to 25

Small, filtered, high concentration

CO-AF

55 to 90

Small, filtered

CO-AX

55 to 100

Small, low hydrogen cross sensitivity

CO-CE

10 to 25

Combustion, high concentration

CO-CF

55 to 90

Model

Description

CO-BF

80 to 130

Combustion, filtered
Combustion, low hydrogen cross
sensitivity
Compact, filtered

CO-BX

70 to 130

Compact, low hydrogen cross sensitivity

CL2-A1

-350 to -750

Small

B/Compact/7

CL2-B1

-600 to -1150

Compact

A/Miniature/4

ETO-A1

-600 to -1150

Small

B/Compact/7

ETO-B1

2000 to 3200

Compact

A/Miniature/4

H2-AF

10 to 20

Small

B/Compact/7

H2-BF

10 to 25

Compact

Hydrogen
chloride

A/Miniature/4

HCL-A1

80 to 130

Small

B/Compact/7

HCL-B1

150 to 250

Compact

Hydrogen
cyanide

A/Miniature/4

HCN-A1

55 to 85

Small

B/Compact/7

HCN-B1

80 to 140

Compact

Ammonia

B/Compact/7

NH3-B1

25 to 45

Compact

A/Miniature/4

PH3-A1

550 to 900

Small

PH3-B1

600 to 1000

Compact

PH3-BE

15 to 35

Compact, high concentration

H2S-A1

550 to 875

Small

H2S-AE

65 to 105

Small, high concentration

H2S-AH

950 to 1450

Small, high sensitivity

H2S-B1

300 to 450

Compact, unfiltered

H2S-BE

80 to 115

Compact, high concentration

H2S-BH

1500 to 2100

Compact, high sensitivity

NO-A1

320 to 480

Small

NO-AE

40 to 80

Small, high concentration

NO-B1

400 to 620

Compact, filtered

NO2-A1

-250 to -650

Small

NO2-AE

-100 to -170

Small, high concentration

NO2-B1

-450 to -1000

Compact, unfiltered

SO2-AE

80 to 120

Small, high-concentration

SO2-AF

400 to 650

Small, filtered

SO2-BE

70 to 85

Compact, high-concentration

SO2-BF

300 to 480

Compact, filtered

CO-CX
B/Compact/7
Chlorine
Ethylene
oxide
Hydrogen

Phosphine

A/Miniature/4

B/Compact/7

A/Miniature/4
Hydrogen
Sulfide
B/Compact/7

Nitrogen
monoxide

A/Miniature/4

Nitrogen
Dioxide

A/Miniature/4

Sulfur
Dioxide

B/Compact/7

B/Compact/7
A/Miniature/4
B/Compact/7

55 to 100
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City technology [25]
Pollutant

Type

Sensoric

Carbon
Monoxide

A/Miniature/4

B/Compact/7

CO 3E 500 S

Sensitivity,
nA/ppm
70 ± 20

3 Electrode sensor

CO 2E 300

30 ± 12

2 Electrode sensor

CO 3E 300

70 ± 20

4F

70 ±15

4MF

15 ± 5

3 Electrode sensor
3 electrode electrochemical with
filter to remove acid gases
3 electrode electrochemical

2CF

50 ± 20

2 Electrode minature sensor

4CF+

70 ± 15

3 – electrode miniature sensor

7E

100 ± 20

7E/F

100 ± 20

3 Electrode compact sensor
3 Electrode compact sensor with H2S
and SO2 filter
3 Electrode minature sensor

Model

Description

Ethylene
oxide

A/Miniature/4

4ETO

1900 ± 500

B/Compact/7

7ETO

2250 ± 650

Ammonia

Sensoric

NH3 3E 100

90 ± 40

Sensoric

NH3 3E 100 SE

130 ± 30

Sensoric

NH3 3E 1000

8±4

Sensoric

NH3 3E 1000 SE

8±4

3 Electrode compact sensor
3 Electrode sensor with organic
electrolyte
3 Electrode sensor
3 Electrode sensor with organic
electrolyte
3 Electrode sensor

Sensoric

NH3 3E 500 SE

35 ± 15

3 Electrode sensor

Sensoric

NH3 3E 5000 SE

4±2

3 Electrode sensor

Sensoric

NO 3E 100

45 ± 15

3 Electrode sensor

4 Series

4NT

400 ± 80

3 Electrode minature sensor

7 Series

7NT

550 ± 110

Sensoric

NO2 3E 50

200 ± 40

4 Series

4ND

600 ± 150

3 Electrode compact sensor
3 Electrode sensor with organic
electrolyte;
3 Electrode minature sensor

7 Series

7NDH

1400 ± 300

3 Electrode compact sensor

O3 3E 1

1000 - 2000

O3 3E 1 F

450 ± 150

3 Electrode sensor with organic
electrolyte

B/Compact/7

7OZ

7200 ± 2300

3 Electrode compact sensor

A/Miniature/4

4S Rev. 2

500 ± 100

3 Electrode sensor with H2S filter

7SH

1250 ± 250

3 Electrode compact sensor

7ST/F

370 ± 70

3 Electrode sensor with H2S filter

Nitrogen
monoxide

Nitrogen
Dioxide

Ozone

Sulfur
Dioxide

Sensoric

B/Compact/7
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Membrapor [27]
Pollutant

Type

A/Miniature/4
Br2, Bromine
/Cl2, chlorine
B/Compact/7

Model

Sensitivity,
nA/ppm

Cl2/M-20

600.0 ± 150.0

Cl2/M-200

120.0 ± 30.0

Cl2/M-2EG

280.0 ± 80.0

Cl2/C-20

900.0 ± 250.0

Cl2/C-5000

4.0 ± 1.0
4600.0 ±
1200.0
2300.0 ±
800.0
60.0 ± 15.0
1000.0 ±
500.0
4600.0 ±
1200.0

CH2O/M-10

CH2O,
Formaldehyde

A/Miniature/4

CH2O/M-10-2E
CH2O/M-1000
CH2O/M-20-2E

B/Compact/7

A/Miniature/4
C2H4, Ethene,
Ethylene
B/Compact/7

CH2O/C-10

CO, Carbon
Monoxide

A/Miniature/4

A/Miniature/4

3-electrode sensor
2-electrode sensor
3-electrode sensor,
highly sensitive
3-electrode sensor,
highly sensitive
3-electrode sensor

12.0 ± 4.0

C2H4/M-200

65.0 ± 25.0

C2H4/C-10

400.0 ± 120.0

C2H4/C-1500

12.0 ± 4.0

3-electrode sensor
3-electrode sensor,
highly sensitive
3-electrode sensor

C2H4/C-200

100.0 ± 30.0
1900.0 ±
400.0
200.0 ± 40.0

3-electrode sensor
3-electrode sensor,
highly sensitive
3-electrode sensor

ETO/M-500

25.0 ± 6.0
1000.0 ±
200.0
50.0 ± 15.0

3-electrode sensor
3-electrode sensor,
highly sensitive
3-electrode sensor

ETO/C-100

200.0 ± 40.0

3-electrode sensor

ETO/C-1000

50.0 ± 15.0
2200.0 ±
600.0
15.0 ± 8.0
1000.0 ±
250.0

3-electrode sensor
3-electrode sensor,
highly sensitive
3-electrode sensor
Methanol / Ethanol
Measurement
3-electrode sensor
with filter
3-electrode sensor
with filter
3-electrode sensor
with filter
2-electrode sensor
3-electrode sensor
with filter
3-electrode sensor

ETO/M-1000

ETO/C-20
ETO/C-5000

R3COH,
Alcohols

2-electrode sensor

C2H4/M-1500

ETO/M-20

B/Compact/7

2-electrode sensor
3-electrode sensor
highly sensitive
3-electrode sensor
3-electrode sensor,
highly sensitive

400.0 ± 300.0

ETO/M-100

C2H4O,
Ethylene
Oxide

3-electrode sensor,
highly sensitive
3-electrode sensor

C2H4/M-10

ETO/M-10
A/Miniature/4

Description

Alc/M-200
CO/MF-1000

50.0 ± 15.0

CO/MF-200

500.0 ± 150.0

CO/MF-2000

30.0 ± 5.0

CO/MF-2E

50.0 ± 15.0

CO/MF-500

70.0 ± 20.0

CO/MFA-500

70.0 ± 15.0
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highly selective

B/Compact/7

A/Miniature/4

H2, Hydrogen
B/Compact/7

A/Miniature/4

CO/C-1000

100.0 ± 20.0

CO/C-200

900.0 ± 150.0

CO/CF-1000

100.0 ± 20.0

CO/CF-200

700.0 ± 120.0

CO/CF-200-4E

470.0 ± 120.0

CO/CF-2000
CO/CF-20004E
CO/CF-4000

50.0 ± 10.0

30.0 ± 6.0

3-electrode sensor
3-electrode sensor
highly sensitive
3-electrode sensor
with filter
highly sensitive, with
filter
Hydrogen
compensated
Emission Monitoring
Hydrogen
compensated
Emission Monitoring

CO/CF-40000

6.0 ± 2.0

Emission Monitoring

CO/CF-500

160.0 ± 30.0

with filter

CO/CFA-1000

100.0 ± 20.0

highly selective

CO/CFA-10000

15.0 ± 4.0

highly selective

CO/CFA-500

160.0 ± 30.0

highly selective

CO/CFA-5000

30.0 ± 5.0

CO/CFL-4E

700.0 ± 120.0

H2/M-1000

25.0 ± 10.0

H2/M-4000

10.0 ± 6.0

highly selective
for lowest gas
concentrations
3-electrode sensor
highly sensitive
3-electrode sensor

H2/M-40000

7.0 ± 4.0

H2/C-2000

23.0 ± 8.0

H2/C-20000

8.0 ± 3.0

H2/C-5000

9.5 ± 2.5

H2/CA-1000

28.5 ± 11.5

H2/CB-1000

28.5 ± 11.5

H2/CT-10000

15.0 ± 6.0

H2/CT-40000

5.5 ± 2.0

3-electrode sensor
3-electrode sensor
highly selective
3-electrode sensor
more gastight
3-electrode sensor at
high humidity
at high humidity

H2S/M-100

700.0 ± 140.0

3-electrode sensor

H2S/M-200-2E

250.0 ± 50.0

2-electrode sensor

H2S/M-2000

H2S/M-500

50.0 ± 10.0
1200.0 ±
250.0
100.0 ± 20.0

3-electrode sensor
3-electrode sensor
highly sensitive
3-electrode sensor

H2S/C-1000

100.0 ± 20.0

3-electrode sensor

H2S/C-200

370.0 ± 80.0

3-electrode sensor

H2S/C-2000

50.0 ± 9.0
1700.0 ±
300.0
200.0 ± 40.0

3-electrode sensor
3-electrode sensor
highly sensitive
3-electrode sensor

H2S/M-50
H2S,
Hydrogen
Sulfide
B/Compact/7

H2S/C-50
H2S/C-500

80.0 ± 25.0
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3-electrode sensor
3-electrode sensor
highly sensitive
3-electrode sensor

A/Miniature/4
HBr,
Hydrogen
Bromide /
HCl, Hydrogen
B/Compact/7
Chloride

HCN,
Hydrogen
Cyanide
H2O2,
Hydrogen
Peroxide

A/Miniature/4
B/Compact/7

H2S/C-5000

26.0 ± 6.0

3-electrode sensor

H2S/CP-100

550.0 ± 110.0

more gastight

H2S/CP-10000

15.0 ± 5.0

more gastight

H2S/CP-2000

50.0 ± 9.0

more gastight

H2S/CP-500

200.0 ± 40.0

more gastight

H2S/CP-5000

25.0 ± 6.0

HCl/M-20

400.0 ± 150.0

HCl/M-200

80.0 ± 30.0

more gastight
3-electrode sensor
highly sensitive
short response time

HCl/C-1000

20.0 ± 5.0

short response time

HCl/C-20

450.0 ± 150.0

highly sensitive

HCl/C-200

100.0 ± 35.0

short response time

HCN/M-100

140.0 ± 40.0

HCN/M-50

200.0 ± 50.0

HCN/C-100

600.0 ± 150.0

short response time
short response time
highly sensitive
3-electrode sensor
highly sensitive
3-electrode sensor
highly sensitive
3-electrode sensor

H2O2/CB-2000

1100.0 ±
150.0
50.0 ± 10.0

H2O2/CB-500

200.0 ± 50.0

NH3/MR-100

110.0 ± 30.0

NH3/MR-1002E

50.0 ± 12.0

2-electrode sensor

NH3/MR-1000

25.0 ± 9.0

3-elect. sensor short
response time

19.0 ± 7.0

2-electrode sensor

2.5 ± 0.6

3-electrode sensor

H2O2/CB-100
B/Compact/7

NH3/MR-10002E
A/Miniature/4
NH3/MR10000
NH3,
Ammonia

NH3/MR-2000

12.0 ± 4.0

NH3/MR-500

35.0 ± 15.0

NH3/MR-5000

5.0 ± 1.8

NH3/CR-1000

25.0 ± 8.0

NH3/CR-10000

2.5 ± 0.5

NH3/CR-200

112.0 ± 40.0

NH3/CR-5000

6.0 ± 2.0

NO/M-1000

100.0 ± 25.0
1000.0 ±
400.0
360.0 ± 80.0
5000.0 ±
2000.0
550.0 ± 110.0

B/Compact/7

A/Miniature/4
NO, Nitric
Oxide

NO/M-25
NO/M-250

B/Compact/7

NO/C-1
NO/C-100
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3-electrode sensor
3-electrode sensor
highly sensitive

3-elect. sensor short
response time
3-elect. sensor short
response time
3-elect. sensor short
response time
3-elect. sensor short
response time
3-elect. sensor short
response time
3-electrode sensor
highly sensitive
3-elect. sensor short
response time
3-electrode sensor
3-electrode sensor
highly sensitive
3-electrode sensor
3-electrode sensor
highly sensitive
3-electrode sensor

A/Miniature/4
NO2, Nitrogen
Dioxide

NO/C-25

2000.0 ±
400.0

NO/CF-100

400.0 ± 80.0

NO/CF-2000

100.0 ± 20.0

NO2/M-100

120.0 ± 30.0

NO2/M-20

600.0 ± 150.0

NO2/M-2E

300.0 ± 70.0

NO2/M-2EG

300.0 ± 70.0
2500.0 ±
1000.0
1100.0 ±
300.0
370.0 ± 70.0
1300.0 ±
300.0

NO2/C-1
B/Compact/7

NO2/C-20
NO2/C-500
O2/M-1

O2, Oxygen

A/Miniature/4

A/Miniature/4

O2/M-100

100.0 ± 24.0

O3/M-100

400.0 ± 50.0
1000.0 ±
350.0
650.0 ± 150.0

O3/M-5
O3/C-100
O3/C-1000

O3, Ozone

O3/C-2
B/Compact/7

O3/C-200
O3/C-5
O3/C-5000
PH3/M-20

A/Miniature/4

PH3/M-2000

50.0 ± 15.0

PH3/M-5

3500.0 ±
1000.0

PH3/C-1000

100.0 ± 25.0

PH3/C-2000

70.0 ± 20.0

PH3/C-4000

30.0 ± 8.0

PH3/C-5

4000.0 ±
1200.0

PH3/C-500

200.0 ± 50.0

A/Miniature/4

SiH4/M-50

500.0 ± 60.0

B/Compact/7

SiH4/C-50

PH3,
Phosphine
B/Compact/7

SiH4, Silane

SO2, Sulfur
Dioxide

170.0 ± 30.0
3000.0 ±
1200.0
400.0 ± 130.0
1500.0 ±
500.0
30.0 ± 10.0
1000.0 ±
300.0

A/Miniature/4

SO2/M-100-2E

1000.0 ±
300.0
300.0 ± 80.0

SO2/M-20

500.0 ± 90.0
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3-electrode sensor
highly sensitive
3-electrode sensor
with filter
Emission Monitoring
3-electrode sensor
3-electrode sensor
highly sensitive
2-electrode sensor
2-electrode sensor
3-electrode sensor
highly sensitive
3-electrode sensor
highly sensitive
Emission Monitoring
3-elect. sensor short
response timeS
3-elect. sensor short
response time
3-electrode sensor
3-electrodes, highly
sensitive
3-electrode sensor
3-electrode sensor
3-electrode sensor
highly sensitive
3-electrode sensor
3-electrode sensor
highly sensitive
3-electrode sensor
3-elect. sensor short
response time
3-elect. sensor short
response time
3-electrode sensor
highly sensitive
3-elect. sensor short
response time
3-elect. sensor short
response time
3-elect. sensor short
response time
3-electrode sensor
highly sensitive
3-elect. sensor short
response time
3-electrode sensor
highly sensitive
3-electrode sensor
2-electrode sensor
3-electrode sensor
highly sensitive

SO2/M-2E

450.0 ± 80.0

SO2/MF-100

370.0 ± 70.0

SO2/MF-1000

50.0 ± 10.0

SO2/MF-10000

20.0 ± 5.0

SO2/MF-20

500.0 ± 90.0

SO2/MF-2000

25.0 ± 5.0

SO2/C-2000

5000.0 ±
2000.0
370.0 ± 70.0
1000.0 ±
300.0
100.0 ± 20.0

SO2/CF-100

370.0 ± 70.0

SO2/CF-10000

20.0 ± 5.0

SO2/CF-20

550.0 ± 150.0

SO2/CF-2000

100.0 ± 20.0

SO2/C-1
SO2/C-100
SO2/C-20
B/Compact/7
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2-electrode sensor
3-electrode sensor
with filter
3-electrode sensor
with filter
3-electrode sensor
highly sensitive, with
filter
3-electrode sensor
with filter
3-electrode sensor
highly sensitive
3-electrode sensor
3-electrode sensor
highly sensitive
3-electrode sensor
3-electrode sensor
with filter
3-electrode sensor
with filter
highly sensitive, with
Filter
Emission Monitoring

SGX Sensortech [26]
Pollutant

Carbon
Monoxide

Ethylene
oxide

Type

Model

Sensitivity,
Description
nA/ppm

EC4-500CO

70 ± 15

3 Electrode
sensor

http://www.sgxsensortech.com/sensor-selector/#collapsedatasheets-1

SGX-4CO

70 ± 25

3 electrode
sensor

http://www.sgxsensortech.com/content/uploads/2014/10/DS0138-SGX-4CO-V1.pdf

EC4-2000CO

28 ± 10

3 electrode
sensor

http://www.sgxsensortech.com/content/uploads/2014/07/EC42000-CO1.pdf

7-Series

SGX-7CO

100 ± 20

3 Electrode
sensor

http://www.sgxsensortech.com/content/uploads/2014/07/DS0144-SGX-7CO-V2.pdf

B or 4Series

EC4-10ETO

1900 ± 800

3 Electrode
sensor

http://www.sgxsensortech.com/content/uploads/2014/07/DS0201-EC4-10-ETO-Datasheet-V1.pdf

B or 4 Serie

SGX-4NH3

100 ± 30

3 Electrode
sensor

http://www.sgxsensortech.com/content/uploads/2015/04/DS0199-SGX-4NH3-V2.pdf

A or 7 series

SGX-7NH3

115 ± 45

3 Electrode
sensor

http://www.sgxsensortech.com/content/uploads/2014/07/DS0146-SGX-7NH3-V5.pdf

B or 4 Series

EC4-250NO

400 ± 80

3 Electrode
sensor

http://www.sgxsensortech.com/content/uploads/2014/07/EC4250-NO1.pdf

B or 4 Series

EC4-2000NO

43 ±22

3 Electrode
sensor

http://www.sgxsensortech.com/content/uploads/2014/07/EC42000-NO1.pdf

A or 7 Series

SGX-7NH3

115 ±45

3 Electrode
sensor

http://www.sgxsensortech.com/content/uploads/2014/07/DS0146-SGX-7NH3-V5.pdf

B or 4
Series

EC4-20NO2

600 ± 150

3 Electrode
compact
sensor

http://www.sgxsensortech.com/content/uploads/2014/07/EC420-NO21.pdf

B or 4Series

EC4-20SO2

400 ± 200

3 Electrode
sensor

http://www.sgxsensortech.com/content/uploads/2014/07/EC420-SO21.pdf

B or 4Series

EC4-2000SO2

14 ± 6

3 Electrode
sensor

http://www.sgxsensortech.com/content/uploads/2014/07/EC42000-SO21.pdf

4-Series

Ammonia

Nitrogen
monoxide

Nitrogen
Dioxide

Sulfur Dioxide
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9.4 Communication protocol
9.4.1 AirSensEUR Communication Protocol overview
This document describes the communication protocol implemented by AirSensEUR, the chemical sensors board R20
and associated firmware release.
Author: Marco Signorini
Document Revision: 1.2 – 2015/04/04

9.4.2 Physical Layer
The communication with the board is made through a serial line running at 9600bps, 8 bit, no parity. Line level is 5V
(TTL). An opto-coupled bi-directional insulated USB adapter is provided with the board to easily connect the board to
a host PC.

9.4.3 Communication syntax
The board could accept a set of commands. Each command set is identified by a frame. A frame is limited by a set of
braces containing a letter and two or more digits. Commands are identified by a letter and are case sensitive. Optional
parameters are encoded with hexadecimal values.
The board acknowledges each command by repeating the command itself and appending result values, if any. Each
error or not valid command is acknowledged by the general string {*}

9.4.4 Start and stop commands
Start sampling
Purpose: Start the sampling process
Command: S
Parameters: None
Returns: An acknowledgement of the command as soon as the sampling process started
Example:
Tx: {S}
Rx: {S}
Stop sampling
Purpose: Stop the sampling process
Command: X
Parameters: None
Returns: An acknowledgement of the command as soon as the sampling process stopped
Example:
Tx: {X}
Rx: {X}

9.4.5 Read commands:
Sensor Name Inquiry
Purpose: Retrieve the channel name associated to a sensor
Command: I
Parameters:
Byte1: the sensor channel ID (from 0 to 6)
Returns:
Byte1: the sensor channel ID (from 0 to 6)
Byte2 to 9: the name of the selected channel sensor
Example:
Tx: {I00}
Inquiry name for sensor 00
Rx: {I004E4F2033452031}
Name for sensor 00 is “NO 3E 1”
Echo command
Purpose: Check the connection with the board
Command: E
Parameters: None
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Returns: A replica of the incoming frame. Useful for connection test.
Example:
Tx: {E}
Rx: {E}
Get the Prescaler size
Purpose: Retrieve the time base associated to the specified sampler channel
Command: Q
Parameters:
Byte1: the sensor channel ID (from 0 to 6)
Returns:
Byte1: the sensor channel ID (from 0 to 6)
Byte2: The time base associated to the specified sampler channel
Example:
Tx: {Q00}
Get the sample time base associated to the channel 0
Rx: {Q0031} The sample time for the channel 00 is 0.5s (31hex is 49 decimal
→ one sample each (49+1)*10ms)s
Get IIR denominators
Purpose: Each sample is filter by two single order IIR filters where the denominator values could be set. The
denominator is always a value multiple of 2. This command reads the denominators set for the IIR filters.
Command: B
Parameters:
Byte1: the sensor channel ID (from 0 to 6)
Returns: A frame containing:
Byte1: channel ID referring to
Byte2: the denominator for the 1st IIR filter
Byte3: the denominator for the 2nd IIR filter
Example:
Tx: {B00}
Read the IIR denominators for the channel 0
Rx: {B000204} The IIR denominators for the channel 0 are, respectively, 2 and 4
Get the decimation filter size
Purpose: each filtered sample is decimated by a decimation filter. This command reads the size of the decimation
filter.
Command: F
Parameters:
Byte1: the sensor channel ID (from 0 to 6)
Returns:
Byte1: the sensor channel ID (from 0 to 6)
Byte2: the decimation filter size (from 0: filter disabled, to 255: take one sample each 255 incoming samples)
Example:
Tx: {F03}
Get the decimation filter size for the channel 3
Rx: {F0300} The decimation filter for channel 3 is disabled
Read the averager filter size
Purpose: Each sample extracted from the decimation filter is averaged by mean of a moving average filter. This
command read the size of the moving average window
Command: N
Parameters:
Byte1: the sensor channel ID (from 0 to 6)
Returns:
Byte1: the sensor channel ID (from 0 to 6)
Byte2: the average filter size in sample units.
Example:
Tx: {N00}
Get the averager length for the channel 0
Rx: {N003C} The averager length for channel 0 is 60 samples
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Read Analog Front End setup
Purpose: Each chemical sensor channel is equipped by a programmable analog front end implemented by the
LMP91000 integrated circuit. This command reads the internal registers for the specified channel AFE. Details on
values be assigned to the internal registers are reported on the device datasheet.
Command: T
Parameters:
Byte1: the chemical sensor channel ID (from 0 to 3)
Returns:
Byte1: the chemical sensor channel ID (from 0 to 3)
Byte2: TIA register value
Byte3: REF register value
Byte4: MODE register value
Example:
Tx: {T00}
Rx: {T001F9603}
The channel 0 analog front end is configured as:
Gain: 350 kOhm
Load: 100 Ohm
Reference: External
Internal zero: 20%
Bias polarity: Positive
Bias percentage: 10%
Shorting FET: disabled
Working mode: 3-lead amp cell
Read reference voltages
Purpose: Each chemical sensor channel is equipped with a precise programmable three channel voltage reference
generator. This command reads the generator registers.
Command: H
Parameters:
Byte1: the chemical sensor channel ID (from 0 to 3)
Byte2: the voltage reference ID to be programmed.
00: Vin- A/D input
01: Vref A/D
02: LMP91000 external VREF
Returns:
Byte1: the chemical sensor channel ID (from 0 to 3)
Byte2: the voltage reference ID to be programmed.
00: Vin- A/D input
01: Vref A/D
02: LMP91000 external VREF
Byte3-4: a value representing the voltage to be generated (range: 0-4095)
Byte5: the overall output stage multiplier
00: x1 (output voltage is 0-2.5V)
01: x2 (output voltage is 0-5V)
Example:
Tx: {H0300}
Retrieve the reference applied to the third channel A/D input VInRx: {H0300029A00} The reference is 0.415V (Gain = 1; Value = 2A9hex = 681dec
→ V = 2.5V*(681/4096) = 0.415V)
Read last sample
Purpose: Retrieve the last sample for the specified channel. The read value is the result of the sample and processing
chain composed by the IIRs, decimation and moving average filters.
Command: G
Parameters:
Byte1: the sensor channel ID (from 0 to 6)
Returns:
Byte1: the sensor channel ID (from 0 to 6)
Byte2-3: the last sample, as 16 bit unsigned value
Byte4-7: the timestamp for the taken sample (as 32 bit unsigned value) in 10ms units
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Example:
Tx: {G01}
Get last sample for channel 1
Rx: {G01FBC4001200B2}
Last sample is 0xFBC4 taken at 0x001200B2
NOTE: The last sample value ranges from 0 to 65535 and, for chemical sensors, is a flat representation of what the
A/D converter reads. This is different for temperature, humidity and pressure sensors where the following relations
need to be used to retrieve the physical value:
Temperature [C]= (sample/16384*165) – 40.0
Humidity [%RH] = (sample/16384) * 100.0
Pressure [hPa] = sample / 48.0
Get the free memory RAM size
Purpose: moving average filters and internal program use a variable amount of RAM. This command allows to read
the available RAM amount.
Command: M
Parameters: None
Returns: The amount of available memory RAM in bytes in 16 bit unsigned value
Example:
Tx: {M}
Rx: {M02DB} 731 bytes available
Load Preset
Purpose: The whole configuration for each channel could be saved, as a snapshot, into an persistent internal memory.
This command triggers a snapshot load for a specified channel.
Command: L
Parameters:
Byte1: the sensor channel ID (from 0 to 6)
Returns: An acknowledge frame
Example:
Tx: {L00}
Load preset for channel 0
Rx: {L00}

9.4.6 Write commands
Set the Prescaler size
Purpose: Define the time base for a channel sampler.
Command: P
Parameters:
Byte1: the sensor channel ID (from 0 to 6)
Byte2: the time base expressed in 10 milliseconds/unit (range: 0-255. 0: the sampler takes a new sample each
10ms; 255: the sampler takes a new sample each 2.55s)
Returns: An acknowledgement frame
Example:
Tx: {P0031} Set a sample time base of 0.5s for the channel 0 (31hex is 49 decimal. This specifies a time
base of 49+1 units of 10ms → 0.5s).
Rx: {P00}
Set the IIR denomitators
Purpose: Each sample is filter by two single order IIR filters where the denominator values could be set. The
denominator is always a multiple of 2. This command sets the denominators for the two IIR filters.
Command: A
Parameters:
Byte1: the sensor channel ID (from 0 to 6)
Byte2: the two power factor defining the denominator of the 1st IIR filter (0 and 255 disables the filter; valid
values are 1, 2, 4, 8, 16, 32, 64, 128)
Byte3: the two power factor defining the denominator for the 2nd IIR filter (0 and 255 disables the filter; valid
values are 1, 2, 4, 8, 16, 32, 64, 128)
Returns: An acknowledge frame
Example:
Tx: {A000408} Set the IIR denominators for the channel 0 to, respectively, 4 and 8
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Rx: {A00}
Set the decimation filter size
Purpose: each filtered sample is decimated by a decimation filter. This command sets the size of the decimation filter.
Command: D
Parameters:
Byte1: the sensor channel ID (from 0 to 6)
Byte2: the decimation filter size (from 0: filter disabled, to 255: take one sample each 255 incoming samples)
Returns: An acknowledge frame containing the sensor channel ID
Example:
Tx: {D0105} Channel 1: take one sample every 6 incoming samples
Rx: {D01}
Set the averager filter size
Purpose: Each sample extracted from the decimation filter is averaged by mean of a moving average filter. This
command sets the size of the moving average window
Command: O
Parameters:
Byte1: the sensor channel ID (from 0 to 6)
Byte2: the moving average windows size, in bytes (0: disable the filter)
Returns: An acknowledge frame containing the sensor channel Id
Example:
Tx: {O023C} Set the channel 2 averager length to 60 samples
Rx: {O02}
Write Analog Front End setup
Purpose: Each chemical sensor channel is equipped by a programmable analog front end implemented by the
LMP91000 integrated circuit. This command writes the internal registers for the specified channel and is used to
configure the analog front end in order to adapt it to the attached sensor. Details on values to be assigned to the
internal registers are reported on the device datasheet.
Command: R
Parameters:
Byte1: the chemical sensor channel ID (from 0 to 3)
Byte2: TIA register value
Byte3: REF register value
Byte4: MODE register value
Returns: An acknowledge frame containing the chemical sensor channel ID
Example:
Tx: {R001F9603}
Sets the channel 0 analog front end to:
Gain: 350 kOhm
Load: 100 Ohm
Reference: External
Internal zero: 20%
Bias polarity: Positive
Bias percentage: 10%
Shorting FET: disabled
Working mode: 3-lead amp cell
Rx: {R00}
Setup reference voltages
Purpose: Each chemical sensor channel is equipped with a precise programmable three channel voltage reference
generator. This command sets the generators to provide the required reference voltages.
Command: C
Parameters:
Byte1: the chemical sensor channel ID (from 0 to 3)
Byte2: the voltage reference ID to be programmed.
00: Vin- A/D input
01: Vref A/D
02: LMP91000 external VREF
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Byte3-4: a value representing the voltage to be generated (range: 0-4095)
Byte5: the overall output stage multiplier
00: x1 (output voltage is 0-2.5V)
01: x2 (output voltage is 0-5V)
Returns: An acknowledge frame containing the chemical sensor channel ID
Example:
Tx: {C01000FFF00}
Sets the channel 1 A/D input Vin- pin to 2.5V
Rx: {C01}
NOTE: The output multiplier is common for the three generated references this means is not possible to set up
different gains for references on the same channel.
Save preset
Purpose: The whole configuration for each channel could be saved, as a snapshot, into a persistent internal memory.
This command triggers a snapshot for a specified channel and associate a channel name for it. The saved preset is
automatically recalled each power up or board reset.
Command: W
Parameters:
Byte1: the sensor channel ID (from 0 to 6)
Byte2-9: the sensor name (valid only for channels 0 to 3). The encoded string should be zero terminated.
Returns: An acknowledge frame containing the sensor channel ID
Example:
Tx: {W004E4F203345203100} Save the preset for channel 0, name to “NO 3E 1”
Rx: {W00}
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